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Disclaimer

The manufacturer (MFR) reserves the right to make changes to this 
document and the products which it describes without notice. The 
MFR shall not be liable for technical or editorial errors or omissions 
made herein; nor for incidental or consequential damages resulting 
from the furnishing, performance, or use of this material.
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7

Using Your
ATI Multimedia Center

This chapter explains how to use the special features that your 
ATI Multimedia Center offers.  The Multimedia Center is a suite 
of products that provides TV, Video CD, CD Audio, DVD, and 
File Player in one package.

Because North American and European television use different 
broadcast standards, closed-captioning and related features are 
available only in North America. 

IN THIS CHAPTER...

� Starting ATI Multimedia 
Center on page 8

� TV on page 11

� ATI TV Bar on page 22

� TV-on-Demand™ on page 36

� Digital VCR on page 39

� TV Listings on page 44

� Stills Gallery on page 55

� CD Audio on page 57

� Video CD on page 61

� DVD on page 67

� File Player on page 78

� Schedule on page 83

� TV Out on page 85

� Multi-monitor support on 
page 86

� Teletext on page 86

� Troubleshooting on page 87
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8  Using Your ATI Multimedia Center     
Starting ATI Multimedia Center

Starting from LaunchPad

The LaunchPad provides a convenient way to start all your 
Multimedia Center features — just click the feature you want.   
LaunchPad opens automatically when you start your computer, 
or if you prefer, you can right-click LaunchPad, and uncheck 
Load on Startup in the drop-down menu. 

• To dock LaunchPad, right-click it, then click Dock in the 
menu.  To change the docking position, right-click 
LaunchPad while it is docked, point to Side , then choose a 
location. 

• To change the size of the LaunchPad when it is not docked, 
double-click it or right-click it, and choose a size.

The buttons in the upper right of LaunchPad let you access your 
desktop settings, get Help, and close LaunchPad.  If your 
system does not have a TV tuner, Video In appears in place of 
TV in the LaunchPad.   

Note

TV, DVD, Video CD, and File Player use some of the 
same resources.  If you try to start one of these 
features while another is running, a resource conflict 
message appears.  You have four choices: 

• Run both features with reduced performance, 
where possible. 

• Suspend the first feature while the other is active. 

• Close the first feature. 

• Press Cancel to continue without starting the 
second feature. 
Download from Www.Somanuals.com. All Manuals Search And Download.



Using Your ATI Multimedia Center     9
Starting from Windows® taskbar

1 In the Windows taskbar, click Start.

2 Point at Programs .

3 Point at ATI Multimedia Center .

4 Click CD Audio, DVD, LaunchPad, File Player, TV, or 
Video CD.

For information about using the ATI Multimedia Center 
features, see the online help.

Attaching and Detaching Panels

You can detach the DVD, Video CD, TV, CD Audio, and File 
Player, control panels from their display panels, move them to 
any location on your screen, and re-attach them. 

To detach a panel

Move the cursor to the border of the panel you want to detach.  
As the cursor reaches the border, it changes to the detach 
symbol.  Click the panel, and drag it away.

To attach a panel

Drag a panel to the panel you want to attach until its outline 
changes, then release the mouse button.  The panels will snap 
back together.
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10  Using Your ATI Multimedia Center     
Online Help

Feature Help.  Click the Help button in any display panel to 
open the online help.

Context-Sensitive Help.  Context-sensitive help is always 
available for each feature; just press the F1 key.

Tool Tips.  Simply move the mouse cursor over a control to see 
a description of its purpose.  As you become familiar with your 
ATI Multimedia Center, you may want to turn off Tool Tips — 
click the Show Tool Tips checkbox in the Display tab (for more 
information, see TV display settings on page 16).

ATI Desktop Help.  For help on your ATI video card’s graphics 
features, double-click the ATI icon in the lower-right corner of 
your screen.

F1
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Using Your ATI Multimedia Center     11
TV

Watch Television on your 
computer!  You can 
receive up to 125 cable 
television channels and 70 
antenna channels in 
smooth, full-motion video 
on the whole screen or in 
a window.  

TV delivers advanced  
features: Closed 
Captioning, Video/Still 
Capture, Channel Surfing, 
Scheduled Events, TV 
Listings, Parental Control, and more.  

When you click the logo in the upper left corner of the display 
panel, the “About...” notice appears.  If you have more than one 
feature installed, a Task menu displays available and active 
features.  

For information about using TV controls, see the online help 
and Tool Tips. 

Note
• All channels may not be available in all countries.

• Not all TV features are available with Video-In 
cards.
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12  Using Your ATI Multimedia Center     
To start TV

from LaunchPad

Click TV in the Launchpad.  For information on LaunchPad, 
see page 8.

from Windows® taskbar

1 In the Windows taskbar, click Start, then point at 
Programs .

2 Point at ATI Multimedia Center , then click TV.

You can also start TV from other Multimedia Center 
features installed on your system—DVD, Video CD, 

CD Audio, and File Player.  Click the ATI logo in the upper left 
corner of the feature’s control panel, then click TV. 

Video-In

If there is no TV tuner in your 
computer system, a small 
control panel with controls 
for composite input is 
provided for capturing video from external video sources.  

Note

If you have a Video-In card, the following dialogs and 
features are unavailable: 
• TV Tuner settings (see page 18.)
• Channel Surfing (see page 23.)

• TV-on-Demand (see page 36.)
• Program Lockout (see page 32.)
• Parental Control (see page 33.)
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Using Your ATI Multimedia Center     13
Setting up TV   

The first time you start TV, you must complete the Initialization 
Wizard.  After that, the Wizard will not run unless you want to 
re-run it in order to change settings.  The Initialization Wizard 
guides you quickly and easily through setting up TV channels, 
Parental Control, Sound, and TV-on-Demand. 

Initialization Wizard

Click the Setup button, then click the Display tab.

Click the Initialization Wizard... button.  The TV Channels 
Initialization Wizard appears.  Follow the Wizard’s instructions 
to select cable or antenna, choose the broadcast standard, and to 
scan for active channels. 

• If you have TV Listings installed with its current database, it 
will also add the channel name for each channel.  For more 
information see TV Listings on page 44.

Click Next >.  The TV Parental Control Initialization Wizard  
appears.   Follow the Wizard’s instructions to set or change your 
Parental Control password. 

Click Next >.  The Sound Initialization Wizard  appears.  Follow 
the Wizard’s instructions to set up your audio connection.  

• If you do not hear TV audio, ensure that the TV is tuned to a 
broadcasting channel, and that you have made the correct 
audio connections.  See Troubleshooting on page 87 for more 
information.  

Note

• If you have a Video-In card, only the Sound 
Initialization Wizard is used.

• TV-on-Demand is only available if your card 
supports it.

Note

• Passwords are optional.
• Passwords are case-sensitive, and must be at 

least three characters in length.

• If you forget your password, you will have to 
uninstall and reinstall your TV software. 
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Click Next >.  The TV-on-Demand Initialization Wizard  
appears.  Follow the Wizard’s instructions to set up a temporary 
file and  allocate file space.  Available time is indicated.  The 
Advanced Settings button lets you customize settings for 
image quality and processor load.  

Click Next >.  The End of Initialization Wizard panel appears.  
Click Finish to complete TV setup.

Sizing the TV display 

You can resize the TV display using the mouse, the Maximize 
button, or CTRL key combination. 

• The F2 key hides/shows the control panel, to save desktop 
space. 

To resize the TV display using the mouse

Drag the display’s border.  The TV display maintains a fixed 
aspect ratio (width-to-height) of 4:3 to avoid picture distortion. 

To display TV in full-screen 

Press CTRL+F or ALT+F, or click the Maximize button.  To 
return to the previous size, click  or press the Esc key.

To display preset sizes using the CTRL key 

160 x120 pixels CTRL+1

240 x180 pixels CTRL+2

320 x240 pixels CTRL+3

640 x480 pixels CTRL+4

Toggle between full screen and 
current size

CTRL+F
ALT+F

Increase size of display panel CTRL + Up Arrow

Decrease size of display panel CTRL + Down Arrow

Ctrl
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TV Control menu

You can access TV functions by right-clicking on the video 
viewing area or the control panel.  This is very useful in full-
screen mode.  The following menu items are available: 

Setup Opens the TV setup page.

Always 
On Top

Displays TV on top of other applications.

Hide 
Controls

Hides the TV Control panel.

Zooming
Select zoom ratio (2x, 4x, or 8x) or Unzoom if already 
zoomed.  See Zooming and panning on page 30.

Video 
Size

Indicates the sizes available for the current panel: 
160 x 120 
240 x 180 
320 x 240 
640 x 480 
Full Screen

Connector

Specifies the video input: 

TV Tuner Selects TV Tuner input.

Composite Selects composite video input. 

S-Video Selects S-Video input.

Sound 
Mode

Sets the audio mode:

Captions
when Displays closed captions 
muted when audio is muted.

Stereo Enables stereo TV audio.

Mono Enables monaural TV audio. 

SAP Enables the Secondary Audio Program.

Closed 
Captions

Specifies how closed-captioned text is displayed.  You 
can also enable the Hot Words and TV Magazine 
features.  See Hot Words™ on page 26 and TV Magazine 
on page 28.

About... Displays the About... dialog.

Exit Closes TV.
Download from Www.Somanuals.com. All Manuals Search And Download.



16  Using Your ATI Multimedia Center     
TV display settings

The Display settings page lets you control how video is 
displayed in TV.

To open the Display settings page

Click the Setup button in the TV control panel, then 
click the Display tab.

Screen
Size

Indicates the sizes available for the current panel.  If the 
current panel does not support resizing, the values are 
greyed-out.

Tool
Tips

Show Tool Tip
Show helpful aids for using TV when you point at a control 
with your mouse.

Show Shortcut
Show keyboard shortcuts when you point at a control with 
your mouse.

Display
Feature

Video Desktop
When TV is minimized, TV display replaces your desktop 
pattern.

Fixed Aspect Ratio
Click to preserve the width-to-height ratio when you resize 
or zoom the display.

Crop Edges
Crop image edges to hide overscan noise.

Always On Top
Display TV on top of other applications.

Auto Hide Controls when in full screen 
Hide TV controls when displaying TV in full screen.

Hide
Player
Hotkey

Specify a keyboard key that hides/displays TV.

Initialization 
Wizard

Re-runs the Initialization Wizard. See Initialization Wizard 
on page 13.
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TV video settings

The video settings page lets you choose a video connector and  
fine-tune video characteristics. 

To open the Video settings page

Click the Setup button in the Television control panel, 
then click the Video tab.

Connector
Choose cable, composite or S-Video input.
• If you choose Composite or S-Video, you must specify 

the Broadcast Standard.

Broadcast 
Standard

Choose the broadcast standard: NTSC, PAL, or SECAM.

Video
Properties

Color 
Adjusts the amount of color in the image.

Brightness 
Adjust the amount of white in the image. 

Contrast 
Adjusts the gradation of tones between light and dark 
areas.

Tint 
Adjusts the balance of red-to-blue in the image. 
• Tint is not adjustable for PAL or SECAM. 
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TV Tuner settings

The tuner settings page lets you autoscan for active TV 
channels, choose cable or antenna input, name channels, and set 
channel-specific options.

To open the Tuner settings page

Click the Setup button in the TV control panel, then 
click the TV Tuner tab.

Channel Property Details

When you select a channel and then click the Details... button in 
the TV Tuner settings page, the Channel Property Details page 
opens to let you set properties for particular channels—favorites 
list, channel assignment, and properties for audio, video, 
program lockout, and closed captioning.

For example, in the Channel Specific Settings Video page, you 
could change a channel to SECAM when the other channels are 
(by default) PAL.  In the Closed Captioning page you could 
enable a set of Hot Words specifically for a particular channel. 

Channel 
Name

You can enter channel names

Details...
Select a channel, then click the Details... button to open 
the Channel Property Details page (see Channel 
Property Details on page 18).

Autoscan
Scans for all active TV channels, and stores them when 
you click the Set button.

Cable 
Standard

Selects the country and cable or antenna.
Download from Www.Somanuals.com. All Manuals Search And Download.



Using Your ATI Multimedia Center     19
Channel
Name

Type a name for the channel.

Number Displays the channel number.

Tunes to 
Station

Specify the TV station that is received when you tune to a 
particular channel.  For example, you could assign the 
actual channel 5 to the Television’s channel 2.  
Autoscanning returns all channel assignments to normal 
(see Autoscan on page 18).

Channel in
Favorite List

Check to add the channel to the channels that TV 
receives when you click the channel up/down buttons).  
To remove a channel, uncheck it.

Channel in
Visual
Selection List

Check to add the channel to the Visual Selection list (see 
Channel Surfing on page 23).  To remove a channel, 
uncheck it.

Channel
Specific
Settings

Audio
Click Audio, then click Details... to open the Sound 
details page.

Mute Settings 
Global Uses global settings for 

all channels.
Mute On Mutes selected channel.
Mute Off Cancels all muting.

SAP Settings see Secondary Audio Program 
(SAP) on page 23. 

Global Uses global settings for 
all channels.
that provide it.

Stereo Activates stereo audio for this 
channel, if it provides it.

Mono Activates monaural audio for 
this channel.

SAP Activates SAP for this channel.
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Channel
Specific
Settings

Video 
Click Video, then click Details... to open the Channel 
Based Video Settings page.  Move the sliders to change 
the values

Color Amount of color in the image.
Brightness Balance of light and dark in 

the image.
Contrast Gradation of tone between the 

image’s highlights, midtones 
and shadows.

Tint Balance of red, green, and 
blue in the image.

Broadcast Standard
Choose the broadcast standard for this channel.

Program Lockout 
Click Program Lockout, then click Details... to open the 
Program Lockout Settings page (see Program Lockout 
on page 32).

Closed Captioning 
Click Closed Captioning, then click Details...to open the 
Closed Captioning Channel Settings page (see Closed 
Captioning on page 24). 
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TV Stills Gallery settings

You can capture still images from TV, and save them in the 
Stills Gallery.

To open the TV Stills Gallery settings page

Click the Setup button in the TV control panel, then 
click the Stills Gallery tab.  For information on the 
Stills Gallery, see Stills Gallery on page 55. 

TV Schedule settings

The Scheduler lets you set up TV to watch or record selected 
TV programs at times you specify.  If you have the features 
installed, you can also schedule events for CD Audio, TV 
Magazine, Digital VCR, and File Player. 

To open the Schedule settings page

Click the Setup button in the TV control panel, click the 
Schedule tab, then click the Create New button.  The 

Schedule Wizard will guide you through creating new 
scheduled events.  See Schedule on page 83 for details. 
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ATI TV Bar

Browse the Web and 
watch TV at the same 
time, without resizing 
your windows!  ATI TV 
Bar displays TV in your 
Internet Explorer Web 
Browser. 

North American users can 
also view a display of  
channel names and 
numbers, with continuously updated program information. 

To open ATI TV Bar

1 Launch Internet Explorer.

2 In Explorer’s menu bar, click View , point to Explorer 
Bar , then click ATI TV.

Or click the ATI TV button in Explorer’s menu bar.

• If TV is not running, ATI TV Bar opens it, and displays it in 
the TV Bar.  Closing ATI TV Bar also closes TV.

• If TV is running, it is displayed in TV Bar, and the regular 
TV display disappears from your desktop.  Closing TV Bar 
returns TV to its normal display on your desktop.

• If you resize Explorer, the TV display automatically fits itself 
to the new size.

ATI TV Bar controls

From left to right, the ATI 
TV Bar controls are: 
Channel down, Channel 
up, Volume, Mute, Go to 
top, Page up, Page down, Pause scrolling, Favorites, and Help. 

TV Internet
Explorerlistings

ATI
TV
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Channel Surfing

You can browse through several 
TV channels simultaneously, 
and select channels by clicking 
on “thumbnail” images 
(miniature representations) of 
the channels.  Each thumbnail 
displays the channel number, 
and is regularly updated to 
display the current program.

• If any channel in the selection list is a locked-out channel 
(see Program Lockout on page 32), a password is required to 
access it.  If a password is not entered, only unlocked 
channels are displayed.

• After an autoscan (see Autoscan on page 18), all detected 
channels are included in the selection list.  A magnifying 
glass appears to the left of the lock-out icon.  Click the 
magnifying glass button to add or remove the channel from 
the selection list.

• Most controls are disabled during Channel Surfing.

To use Channel Surfing

1  Click the Channel Surf button in the TV control 
panel.

A grid of thumbnails appears over your TV display.

2 Click the thumbnail for the channel you want to preview.

The channel you clicked becomes “live”, and plays video 
and audio for a few seconds.

3 To select a channel for viewing, double-click a thumbnail.

The grid of thumbnails disappears, and the selected 
channel appears on your screen.
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Closed Captioning

Display closed captioned 
text over video, like a 
standard TV, and/or in a 
separate window beside the 
video.  When you use the 
separate window, you can 
use the scroll bar to review 
the last few minutes of text.  
You can set the background color, the font, and the font color 
for the window.

To display closed-captioned text

Click the Closed Caption button in the TV control panel. 

To close the Closed Captioning window, click the Exit 
button.

Closed Caption settings

The Closed Caption settings page lets you specify how closed 
captioned text is displayed—over video or in a window—and 
the background color, the font, and the font color for the 
window.  You can also set up and enable the HotWords and TV 
Magazine features.

Note Closed-Captioning is only available in North America.
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To set up closed captioning

Click the Setup button in the TV control panel, then 
click the Closed Caption tab. 

Placement

External Window
Displays closed captioned text in its own window.  Click 
Font... to select the display font.

Video Window
Displays closed captioned text superimposed on the 
video.  Click Font... to select the display font.

Solid Background
Displays closed captioned text on a solid background.
Shaded Background
Displays closed captioned text on a shaded background.

HotWords

Enable
Check to enable HotWords when Closed Captioning is on 
(see Hot Words™ on page 26).

HotWords Setup
Opens the HotWords settings page.

TV
Magazine

Enable
Activates TV Magazine (see TV Magazine on page 28.)

TV Magazine Setup
Opens the TV Magazine Setup Wizard.

Closed
Caption
On Mute

Display closed captioned text when the audio is muted.

Show
Alternate
Text If
Present

If T1 mode closed captioned data is present in the 
caption stream, checking this box displays a full page of 
T1 mode, scrollable, closed captioned text.  If you turn off 
Closed Captioning or change channels, the page is 
hidden.
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Hot Words™ 

Have your computer watch TV for you! When you turn on 
Closed Captioning, you can specify words and phrases that 
Television will detect in the closed-captioned text. 

You can set Hot Words to show the matched text, restore TV, 
play a sound, enable TV Magazine, or enable the Digital VCR 
when the Hot Words appear.  You can also have TV 
automatically transcribe the text when the specified words 
appear.

You can enable Hot Words, and then minimize TV; when the 
specified words occur, TV opens.  You specify words using the 
Hot Words setup button in the Closed Caption settings page. 

Note Hot Words is only available in North America.
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To set up Hot Words

Click the Setup button in the Television control panel, 
click Closed Caption, then click the HotWords Setup 
button.  The HotWords Setup Wizard opens.

To enable HotWords, check the Enable box.  The HotWords 
Setup Wizard will guide you through HotWords setup. 

First
Word

Type the first word to be matched.

Match
Type

Choose the type of match you want:
• By Itself  Notify when the First Word occurs.
• Followed by  Notify when the First Word occurs, and 

is immediately followed by the Optional Word you 
specify.

• Not Followed By  Notify when the First Word occurs, 
if it is not immediately followed by the Optional Word.

• In Sentence With  Notify when the First Word 
occurs, if it is in a sentence with the Optional Word.

Optional
Word

Type the word you want to match with the First Word.  
When you specify an Optional Word, the system only 
looks for the First Word+Optional Word combination.

Partial
Check this box to notify when a part of the First Word 
occurs.

Use the Add and Remove buttons to add and remove words from the list.

Actions to take 
when your 
HotWords 
occur.

Show Matched Text
Displays the text that matches your Hot Word(s).

Restore Player
Opens Television in its current state.

Recording

Enable TV Magazine
Activates TV Magazine (see TV Magazine on page 28).

Enable Digital VCR
Activates the Digital VCR (see Digital VCR on page 39).
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TV Magazine

Use TV Magazine to transcribe closed captioned broadcasting, 
including pictures and text.  You can save files as RTF (Rich 
Text Format), which preserves formatting, and can be used in 
many word processors, plain text (TXT), or Hypertext Markup 
Language (HTML).  You can use the Schedule feature to start 
TV Magazine at dates and times you specify (see Schedule on 
page 83). 

To start TV Magazine

Click the Setup button in the Television control panel, 
click the Closed Caption tab, then click the TV 
Magazine Setup button.

To enable TV Magazine, check the Enable box.  The first time 
you use TV Magazine, the TV Magazine Setup Wizard will 
guide you through the setup.

Note

• TV Magazine is only available in North America.
• When TV Magazine is enabled, it transcribes 

closed-captioned text even if the Closed 
Captioning button is off.
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File
Name

Type a name for the file.

File 
Format

Select a file format (RTF, TXT, or HTML).

Options

Overwrite files
Check to overwrite existing files.
Uncheck to keep existing files.

Remove Advertising
Automatically skips commercial advertising when you 
display or transcribe closed-captioned text.  It works best 
with programs that use scrolling transcripts rather than 
“text bubbles” to record closed-captioned text; for 
example: Talk shows, News broadcasts, Sports, and 
Soap operas. 

(Depending upon the closed-captioning format, 
commercials may occasionally be recorded—a little 
experimentation will show you how to get the best 
results.) 

Case Conversion
Convert all characters to upper or lower case.

Stop
Transcribing
After

Specify the number of minutes to transcribe.

Select
Layout

No image
No images are saved.

Images on Left
Images are placed on the left, text on the right.

Images on Right
Images are placed on the right, text on the left.

Alternate images
Images and text alternate left and right.

Use black & white pictures
Save images as black & white, to save disk space.

Image Density 
1/page
2/page
4/page
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Secondary Audio Program (SAP)

The Secondary Audio Program can be used to broadcast, for 
example, language translations, reading services for the visually 
impaired, weather forecasts, or information about a show. 

To hear the Secondary Audio Program

Right-click the Mute button in the Television control 
panel, and click Sap in the drop-down menu.

You can also use the menu to:

• Turn on captions when the audio is muted.

• Switch from stereo to mono.

Zooming and panning

You can zoom in on the video in the Display panel to enlarge a 
selected portion of the screen, and return your display to 
normal.  You can also pan (move the image horizontally and 
vertically) in the zoomed area.

To zoom

Click within the display panel, 
then hold down the mouse button 
and draw a rectangle around the 
area you want to zoom.  

 Or, right-click the 1:1 button  
to open a menu where you can 
set the zoom level— Zoom x2, 
Zoom x4, or Zoom x8.

To pan in the zoomed area

Move your mouse within the zoomed area to pan horizontally or 
vertically.

Note
• Not all television stations broadcast stereo or 

SAP.

• SAP is not available in Japanese versions of TV.
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To unzoom 

Right-click in the display panel to open the control menu, point 
at Zooming , then click Unzoom, or 

 Click the 1:1 button in the control panel.

Video Desktop

To replace your desktop pattern with live TV display 
when you minimize TV 

Click the Setup button in the Television control panel,  
click the Display tab, then check Video Desktop.

When you minimize Television, live TV display 
replaces your desktop.

A TV icon appears 
in the “tray” on 
the right side of 

the Windows® taskbar.  
Click the icon to display a small control panel that you can use 
to change channels and control the volume.  Closed-captioned 
information is not displayed.

If you do not have a TV 
tuner, this control panel 
containing volume and 
mute controls is available.

To restore your desktop pattern and TV 

Click the TV button (or the Video button, if you have a Video-
In card) in the Windows® taskbar.
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Program Lockout

Program Lockout lets you block particular programs at specific 
times, and set a password  to unlock them.  Use the Program 
Lockout page to specify channel, time, and duration.  

To set program lockout

1  Click the Setup button in the Television control 
panel, then click the TV Tuner tab.

2 Click the channel you want, then click the Details... button.

3 Click Program Lockout, then click the Details... button.

4 Click Create New.

The Program Lockout Wizard guides you through the 
lockout procedure.

In the channel list, locked-out channels have a 
padlock to the right of the channel name.

To remove program lockout

1  Click the Setup button in the Television control 
panel, then click the TV Tuner tab.

2 Click the channel you want to unlock, then click the 
Details... button.

3 Click Program Lockout, then click the Details... button.

4 Select the program you want to unlock.

5 Click the Delete button.  To remove all program locks, click 
the Delete All button.

6 Click OK.

Note

• Passwords are case-sensitive.  For example, 
PASSWORD, Password, and passWord are not 
the same.

• If you forget your password, you must uninstall 
and reinstall your TV  software to view password-
protected programs.
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Parental Control

Parental Control lets you restrict access to TV programs 
depending on their content rating.  The video and audio of 
programs that you restrict will be scrambled until the correct 
password is entered. 

To use Parental Control

 Click the Parental Control button in the Television control 
panel to display a menu of choices.  The selected level is 
checkmarked. 

1 Click the level you want.

The Set Password dialog appears.

2 Type your password in the upper box, then type it in the 
lower box to confirm it.

The following table summarizes the FCC guidelines for 
Parental Control.

Note

• Parental Control is only available for North American 
(NTSC) Television.

• Passwords are case-sensitive, and must be at least 
three characters in length.

• If you forget your password, you must uninstall and 
reinstall your TV software. 

• Parental Control is only available for computer 
systems that have a TV tuner.

• The capture still frames feature is disabled for 
scrambled programs, and video capture records only 
scrambled material.

Programs designed solely for children

TV-Y This program is designed to be appropriate for all children.

TV-Y7 This program is designed for children age 7 and above.

Programs designed for the entire audience

TV-G General audience.

TV-PG Parental guidance suggested.

TV-14 Parents strongly cautioned.

TV-MA Mature audience only.
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Capturing Video and still images

Full-motion video.  The 
Digital VCR lets you capture 
a clip of full-motion video 
plus audio from your video source and save it as an MPEG or 
AVI file on your computer’s hard disk.  See Digital VCR on 
page 39 for details. 

Still images.  Capture full-
color, 24-bit-per-pixel, still 
images from television, and 
MPEG clips (see Video CD on 
page 61), save them, and print 
them.  The images are placed 
in the Stills Gallery, which  saves them as Windows-standard 
bitmaps (.bmp) or a wide variety of standard formats.  

The Stills Gallery also supports most industry-standard graphics 
file formats, so you can insert the images into reports, 
presentations, letters, and other documents, to add impact to 
training applications and presentations.  See Stills Gallery on 
page 55 for details. 

Note
If the program is restricted by Parental Control, still 
capture is disabled (see Parental Control on 
page 33).
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Recording a clip of video and audio from TV

To record a clip of video and audio

Click the Record button in the Television control panel.

The Digital VCR starts recording video and audio to an 
MPEG or AVI file on your computer’s hard disk.  For 
information on specifying capture formats, see Digital VCR 
settings on page 40.

To stop recording, click the Record button in the Digital 
VCR.  A Save As dialog opens, so you can name and save 
the captured video. 

To capture still frames from Television 

Click the Camera button in the Television control panel.  
The current frame is placed in the Stills Gallery (see Stills 
Gallery on page 55). 

Note
If the program is restricted by Parental Control, the 
recorded material is scrambled (see Parental Control 
on page 33.)

Note
If the program is restricted by Parental Control, Still 
Capture is disabled (see Parental Control on 
page 33.)
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TV-on-Demand™

TV-on-Demand (“Time-Shifting”) is available if your graphics 
card supports it (for example, the ALL-IN-WONDER 
RADEON and the ALL-IN-WONDER 128 PRO).  TV-on-
Demand combines the immediacy of live TV with the storage 
and replay capability of a VCR to create a new way to watch 
and interact with TV.  

Live Pause.  With a mouse click, you can pause a live TV 
broadcast, and resume viewing the time-shifted video later, 
without missing any of the action. 

Instant Replay.  If you want to replay a sequence, you can back 
up the program, see what you missed, and then catch up to live 
programming.  You can vary the playback speed or skip ahead 
by a pre-set number of seconds.  You can also export time-
shifted video as an MPEG (.MP2) file. 

To view time-shifted video 

Click the TV-on-Demand button or the Pause button  in 
the TV control panel.  

• When you click the Pause button, the TV control panel 
changes to the TV-on-Demand control panel, the last frame 
of video is displayed, and TV-on-Demand captures live 
video. 

• When you click the Play button , time-shifted video is 
displayed, continuing from where you paused. 

Note

• Because TV-on-Demand records to your hard 
drive, you cannot use the Digital VCR in TV-on-
Demand mode (see Digital VCR on page 39).

• You cannot time-shift copy-protected video 
sources.

The TV control panel 
changes to the TV-on-
Demand control 
panel, and time-
shifted video is 
displayed.

Live TV mode

TV-on-Demand mode
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To return to live broadcasting

Click the Live TV button in the TV-on-Demand control 
panel.  Video recording stops.  To keep recording while 

you watch live TV, stay in TV-on-Demand mode and drag the 
slider to the right (see To move within time-shifted video on 
page 38).

To play time-shifted video 

Click the Play button  in the TV-on-Demand control panel.

To pause time-shifted video 

The Pause button  is displayed in live TV mode or in TV-on-
Demand mode while time-shifted video is playing.  When you 
click the Pause button, time-shifted video stops, a still image is 
displayed, and the Pause button changes to the Play button .

When you click the Play button, time-shifted video resumes 
playback, and the Play button changes to the Pause button. 

To change playback speed in time-shifted video 

Click the Speed button to select playback speed: Slow 
Play (half-speed), Normal Play, and Fast Play (1.5x 
speed).  Right-clicking the Speed button displays a 

menu of speeds.  

• The Speed button is only enabled when you are in TV-on-
Demand mode, but behind Live.

To skip backwards and forwards in time-shifted video 

Click the left button to skip back; click the right button 
to skip forward.  The default settings are:

• Forward: 10 seconds

• Backward: 30 seconds

You can right-click the button to change the time settings to 10 
seconds, 30 seconds, 1 minute, or two minutes. 

Note
If you do not hear TV audio, see Troubleshooting on 
page 87.
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To move within time-shifted video 

Drag the slider with your 
mouse.  The time display 
indicates the position in the 

recorded video.  As you move the slider all the way to the right, 
the time display indicates Live.

To export time-shifted video  

Click the Export button in the TV-on-Demand control 
panel.  A dialog appears, where you can select the 
portion of time-shifted video you want to save (Range:), 

and the location to store it (Output File:).  Exported video is 
saved in MP2 format. 

You can export more quickly if you return to live broadcast 
mode first (but do not return to TV-on-Demand, or you will 
overwrite your previously-recorded video).

Live
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Digital VCR

The Digital VCR provides 
simple controls and 
powerful capture options.  
You can capture a clip of 
full-motion video and audio from your video source and save it 
as an MPEG or AVI file.  You can play captured files in the File 
Player (see File Player on page 78.)  The Schedule feature lets 
you record TV programs on the dates and times you specify (see 
Schedule on page 83). 

To start the Digital VCR

When you capture video (see To record a clip of video and 
audio on page 35) from TV, the Digital VCR opens 
automatically.  If you want the Digital VCR to prompt you 
before recording, click the Prompt before Recording 
checkbox in the Digital VCR tab of the TV Player Setup page 
(see Digital VCR settings on page 40). 

Saving and compressing captured video

The Digital VCR Custom Settings... page lets you compress 
your captured video and save it in several industry-standard 
formats (see Recording Quality in Digital VCR settings on 
page 40).  The quality of the video that you capture depends on 
the following conditions:

• speed of your system (CPU)

• amount of system memory (RAM)

• performance of your hard disk

• size of the video capture window

• Video codec (encoder-decoder) used 

Note

Because TV-on-Demand records to your hard drive, 
you cannot use the Digital VCR in TV-on-Demand 
mode (see TV-on-Demand™ on page 36).  Instead, 
use the Export function when you are in TV-on-
Demand mode (see To export time-shifted video on 
page 38.)
Download from Www.Somanuals.com. All Manuals Search And Download.



40  Using Your ATI Multimedia Center     
Digital VCR settings

Use the Digital VCR settings pages to specify recording quality, 
duration, general options, and custom settings.

To set up the Digital VCR

Click the Setup button in the TV control panel, then 
click the Digital VCR tab. 

Recording
Quality

Check Best Quality, Good Quality, Video CD (see 
Note), or Longest Time.  (The higher the quality, the less 
video you will be able to store on a disk.)  For extremely 
fine control, click the Set Custom button to open the 
Custom Settings page, where you can create and 
modify preset capture formats.

Click the Create New... button to create a new, preset 
capture format.  The Capture Wizard guides you through 
the process. 

Click the Edit... button to modify an existing, preset 
capture format.

• Step 2 of the Capture Wizard provides a 
deinterlacing option.  Select it to prevent horizontal 
streaks in captured video. 

Note:  The Video CD setting lets you create Video-CD-
compliant files that can be played on most consumer DVD 
players.  To create a CD containing the Video CD files, 
you need a writeable CD drive and accompanying CD 
creation software.

Disk 
Space 
Settings

Allocates the amount of disk to store captured video.

Record to Drive 
Select the drive to hold captured video.

Amount of disk space to leave free 
Use the slider to set the amount of space to leave on your 
hard drive.  Use this to prevent the recording from 
completely filling your drive. 

Current
Settings

Displays the video format, size, frame rate, and audio 
format for captured video.

Capture  
Still at 
640 x 480

Capture still images in 640 x 480 pixel format.
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Real-time MPEG encoding

If your computer uses a Pentium® II, Pentium® III, Pentium® 
processor with MMX technology, or an AMD Athlon™  
processor, you can capture video and save it in MPEG format, in 
real time.  

The Digital VCR Custom Settings provide four, pre-set MPEG 
recording settings, as well as AVI, and you can customize video 
and audio settings for your particular purposes.  

To customize MPEG recording settings

1 Click the Setup  button in the TV control panel, then 
click the Digital VCR tab.  

2 Click the Set Custom... button.

The Custom Settings page opens.

3 Select the MPEG format you want to use.  

• To change preset values, click the Edit... button.  The  
Capture Wizard will guide you through making changes. 

• To create a new capture format, click the Create New... 
button.  The Capture Wizard will guide you through 
creating the new format.

Prompt 
Before 
Recording

Do all capture setup, then display a dialog that starts 
capture.

Record for
Check the box, then type the number of hours and 
minutes you want to record.

Note

You should have a good understanding of MPEG 
before changing these settings.  Of course, 
experimentation is a great teacher; if the results are 
not to your liking, simply click Cancel to return to the 
pre-set values.
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Achieving the best results with MPEG video capture

To access MPEG properties

1 Click the setup button  in the Television control panel, 
then click the Digital VCR tab.

2 In Recording Quality, click the Set Custom... button. 

3 Click Best Quality, then click the Edit... button.  

Capture Wizard (Step 1) appears. 

4 Enter a name and description (if desired) for the preset.

5 Click Next >.

Capture Wizard (Step 2) appears. 

6 Select MPEG-1 or MPEG-2, then click Next >.

Capture Wizard (Step 3) appears

To select I-frame-only MPEG capture

This uses less CPU, but requires 2 to 3 times the bit-rate, which 
produces larger files.

1 Click the I Frames Only button. 

2 Click Next>, then click Finish.

To select I, B, P frame MPEG capture

This uses more CPU, but greatly reduces the bit-rate required to 
achieve good quality video.  

1 In Capture Wizard (Step 3), set Number of P Frames in 
Group to 4.

2 Set Number of B Frames in Subgroup to 2.

(Clicking the Default button sets the above values.)

To achieve full 29.97 frames/second capture performance in 
MPEG-1 or MPEG-2 format, we recommend the following 
settings.  Example CPU speeds and bit rates (Mbps) are given, 
but note that some video compresses better than others, 
depending on the amount of rapid motion and the number of 
complex scenes. 
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Video
Format

IBP
Frames
(Mbps)

Minimum 
CPU 
Required

I-Frame
Only
(Mbps)

Minimum
CPU
Required

160x120 1.0 P200-MMX 1.0 P200-MMX

352x240 1.5 PII-266 2.0 P200-MMX

320x480 3.0 PII-400 4.0 PII-266

640x480 4.0 Athlon 600 6.0 PIII-450

720x480 4.0 Athlon 700 6.0 PIII-450

Mbps = Megabits per second, or millions of bits per second.  
1 Mbps is approximately 125Kbytes/second.

• The motion estimation slider can be used to control the quality of the 
video – a high setting (75 or more) uses more CPU, but provides better 
quality video.  A low setting (25 or less) speeds up encoding, but 
produces lower quality video at a given bit-rate.

• The above bit-rate settings are based on a motion estimation setting of 
10.

• If your system is not capable of achieving smooth-looking video at 29.97, 
try the following:
• Capture I frames only.
• Capture using a smaller frame size.
• Capture video only, with no audio.

MPEG-1 decoders are widely used, so video encoded in MPEG-1 format 
can be played on many PCs.  However, MPEG-1 playback on a PC uses the 
Microsoft MPEG-1 decoder, which may not provide the best performance.

MPEG-2 playback on a PC requires an MPEG-2 decoder.  With ATI graphics 
cards, MPEG-2 decoders use the ATI hardware IDCT and motion 
compensation, which provides higher resolution video playback and less 
CPU loading than the Microsoft MPEG-1 decoder.
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TV Listings

Gemstar’s GUIDE Plus+™ is an electronic television 
programming guide for Microsoft Windows.  It provides 
advanced program information, such as station names and 
numbers, as well as program names and details.  

Before you use TV Listings for the first time, it is recommended 
that you complete the TV Initialization Wizard (see Setting up 
TV on page 13).

You can schedule recording and viewing sessions, search for 
programs, and maintain a list of your favorite shows.  For more 
information, see the TV Listings Help. 

To start TV Listings

Click the TV Listings button in the TV control panel, or click 
TV Listings in the LaunchPad. 

To access TV Listings information from TV

• When you Autoscan, TV Listings provides station names 
(see Autoscan in TV Tuner settings on page 18.)

• When you change channels, the current program name, and 
the station name and number are displayed.

• When watching TV, right-click the TV Listings button to get 
the following options:

•TV Program Details  If TV 
Listings has information about 
this program, it displays a 

panel containing detailed program information. 

• Auto Update  As time passes, or as you change channels, 
the TV Program Details panel updates its program 
information. 

• Copy  Check this to copy the TV Program Details panel’s 
information into your Windows clipboard. 

Note
• TV Listings is only available in North America.

• You need an internet connection to download the 
TV listings to your computer.
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• Right-clicking in the text area of the TV Program Details 
panel also provides access to the Auto Update and Copy 
features. 

Setting up TV Listings

Registration

The first time you launch the GUIDE Plus+ system, you will 
need to register.  This allows you to download the listings for 
your area or cable service.

To download updated listings

1 In the File menu, click Download Weekly File ...

The Download Assistant opens.

2 Click the Download button to download the listings.

To make changes, click the Change Settings button.

To customize channels

The Edit menu contains two features related to the channel list:

• Station Lists ... lets you create and maintain a list of stations, 
based on the master list for your area or cable service.

• Channel Number ... lets you assign and maintain channel 
numbers for each station.

Note

When you use TV Listings, the TV Control panel is 
hidden and the following features are unavailable:

• On-screen display of channel information.
• Resizing the Display panel (see page 14).
• Zoom and Pan (see page 30).

• Video Desktop is deactivated when you open TV 
Listings, and reactivated when you close TV 
Listings (see page 31).

TV Listings is unavailable when you use the following 
features:
• Channel Surf (see page 23).
• Video capture (see page 34).
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Getting around

To navigate the various TV Listings views, click the tab for the 
view you want, or select the appropriate view from the View 
menu at the top of the screen.  

Use the mouse or cursor keys to move within the current view.  
Left-click to select an item and display its details in the details 
window above the grid or log.

Right-click to open a pop-up menu with various options:

Recording

TV Listings works with your TV tuner to automatically record 
shows.  When you select a program to record, a pop-up window 
appears, requesting a file name and location to save the file.  

When you select a program for recording, the Record icon 
appears next to the title in any view where that program is 
displayed.

• To remove a program from the Record Schedule, simply click 
the Record icon next to the program title.

Watch
Adds the item to your Watch schedule (see 
Schedules tab on page 51).

Record
Adds the item to your Record schedule (see 
Schedules tab on page 51).

Favorite
Adds the item to your Favorites list (see 
Favorite search on page 49.

Program 
Details

Opens a window that includes a detailed 
description of the program, as well as 
additional air dates.

Go To
Tunes the PIP (Picture-In-Picture—the window 
in the upper left corner of the guide where the 
TV picture is displayed) to the selected station.
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Viewing

TV Listings works with your TV tuner to automatically display 
shows.  When you select a program for viewing, the Watch icon 
appears next to the title in any view where that program is 
displayed.

• To remove a program from the Watch Schedule, simply click 
the Watch icon next to the program title.

Views

There are two, main views for the guide: Grid and Log.

Grid view displays 24 hours of listings in a table (similar to 
your newspaper or cable guide).  Use the arrow keys to scroll 
up, down, left, or right.  You can also scroll using the horizontal 
and vertical scroll bars.

• Scroll to a specific program to display its details in the area 
above the grid.

• To display just the stations you want, use the Station Lists ... 
option in the Edit menu (see To customize channels on 
page 45.)

Log view displays the data in a list, in the following order: 
Date/Station/Category and Title/Episode.  Use the arrow keys to 
scroll up, down, left, or right.  You can also scroll using the 
horizontal and vertical scroll bars.

• Scroll to a specific program to display its details in the area 
above the log.

• To display just the stations you want, use the Station Lists ... 
option in the Edit menu (see To customize channels on 
page 45.)
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Filter options

Click the Filter icon to 
open the Filter options 
dialog, where you can 
adjust the current view 
and quickly locate 
programs.  Select the 
boxes you want to apply 
to the current view, and 
click Close. 

Select the Use Station 
List checkbox to apply 
the most recently customized station list.

Actors tab

The Actors tab displays all actors and actresses starring in all 
the movies in the current listings.  A list of actor names is 
displayed on the left of the screen.  Click the name of the actor 
for whom you want to display all movies and show times.

• Use the arrow keys to scroll up and down in the Actors List.

• You can also type an actor’s partial or full name in the 
textbox above the Actors List to quickly locate that actor.

• Scroll to a specific program to display its details in the area 
above the list.

• To display just the stations you want, use the Station Lists ... 
option in the Edit menu (see To customize channels on 
page 45).
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Categories tab

The Categories tab displays all genre categories in the current 
listings.  A list of genre categories is displayed on the left of the 
screen.

• Click the category you want to view, to display all titles for 
that category on the right side of the screen.

• Double-clicking on categories with a + sign opens a list of 
sub-categories on the right side of the screen.

• Use the arrow keys to scroll up and down in the Categories 
List.  You can also scroll using the horizontal and vertical 
scroll bars.

• Scroll to a specific program to display its details in the area 
above the log.

• To display just the stations you want, use the Station Lists 
option in the Edit menu (see To customize channels on 
page 45).

Searches

GUIDE Plus+ comes with a powerful search engine to help you 
find the programs you want.  You can save and maintain a list of 
custom searches to run each week, as well as a Favorites search 
that tracks your favorite shows and movies.

Favorite search

Access the Favorite search under the Searches tab.  Favorites 
are a special list of show titles that you keep and use to find your 
favorite shows with a mouse click.  You can add and remove 
items from your favorites list from any view in the guide.  

• Favorites is always the first search displayed in the Searches 
tab.  It behaves like other searches, but it cannot be deleted.

• When one of your favorites appears in any view of the guide, 
 appears in front of the title.
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Typically, you use the favorites list to find your preferred shows 
when your data file is updated.  Select the Favorites search from 
the list of searches, and the guide will look up and display all 
your favorite items.  You can then select any or all of these items 
into your Schedule.  You can set Favorites in two ways:

• In any view, select an event you want to place in your 
Favorites list.  Right-click to open the Event menu, then 
select the Favorite option to toggle the item in or out of your 
Favorites list.

• In any list of events, three checkboxes appear in front of the 
event.  The right checkbox is the Favorites indicator; click to 
toggle it.

Movies tab

The Movies tab displays all movie sub-categories for all movies 
in the current listings, on the left side of your screen.

• Click the category you want to view; all titles for that 
category will be displayed on the right side of your screen.

• Use the arrow keys to scroll up and down in the Movies List.  
You can also scroll using the horizontal and vertical scroll 
bars.

• Scroll to a specific program to display its details in the area 
above the log.

• To display just the stations you want, use the Station Lists ... 
option in the Edit menu (see To customize channels on 
page 45).
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Schedules tab

A schedule is a list of TV events that you have selected in any 
view, including search results.  The schedule is in the form of a 
Log View (see page 47).  There are three lists you can choose 
from:

• Watch displays all events with at least the Watch indicator 
set.

• Record displays all events with at least the Record indicator 
set.

• All displays all events with either the Watch or Record 
indicator set.

In any view, when an event has been scheduled, an icon appears 
in front of the title, indicating whether the item is scheduled to 
watch, record, or both.  Scheduled items can be added and 
removed in two ways:

1 In any view, select the event you want to place in your 
schedule, right-click to open the Event menu, then select 
Watch or Record to toggle the item in or out of your list of 
scheduled items.

2 In any list of events, three checkboxes appear in front of the 
event; the left checkbox is the Watch indicator, and the 
center checkbox is the Record indicator.  Click either one to 
toggle it.

Searches tab

The Searches tab displays a list of saved searches, including a 
list of personal Favorites (see Favorite search on page 49), 
which is always the first search in the list.  The Search title is 
automatically updated when you click it.

• To create a new search, click the Search menu, then click 
New Search.  The Search dialog opens.

• To edit a saved search, double-click the search title, or launch 
the Search dialog (as above), then click Load Search.
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Setting search parameters

To start a new search, in the Search menu, click New Search ... 
to open the Search dialog, which you can use to set the 
following options:

Use the icons at the top of the Search dialog to:

• Create a new search

• Load an existing search

• Save the current search criteria

• Run the current search

• Exit the search dialog

Stations

Select All or None using the appropriate 
buttons at the bottom of the list.  To use 
selected stations, click the station names to  
highlight them.

Program 
Categories

Select All or None using the appropriate 
buttons at the bottom of the list.  To use 
selected categories, click the category names 
to  highlight them.

Date/Time 
Ranges

Use the pull-down items to select date ranges, 
and the check boxes to select the hours you 
wish to include in your search.

Rating
Highlight one or more entries in this list to 
search for movies with specific quality ratings.

MPAA
Highlight one or more entries in this list to 
search for movies with specific MPAA ratings.

Parental 
Guidance

Highlight one or more entries in this list to 
search for movies with specific ratings.

Text 
Search

Enter names, titles, and/or keywords in the text 
box.  Check the Title, Desc, and/or 
Performers boxes to search the appropriate 
fields for the text.

Year of 
Release

Use the pull-down items to search for movies 
before, after, or within specific years.
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Sports tab

The Sports tab displays all sports sub-categories for all sporting 
events in the current listings, on the left side of your screen.  
Click the category on the left side of the screen for which you 
want to display all titles.  Titles will appear on the right side of 
the screen.

• If you have the Use Station List checkbox in the Filter 
options checked (see Filter options on page 48), only those 
stations in the currently-selected station list are displayed.

• Use the arrow keys to scroll up, down, left, or right.  You can 
also scroll using the horizontal and vertical scroll bars.

• Scroll to a specific program to display its details in the area 
above the log.

• To display just the stations you want, use the Station Lists ... 
option in the Edit menu (see To customize channels on 
page 45).

Stations tab

The Stations tab displays listings for each station, on the left 
side of your screen.  Click the station you want, or use the arrow 
keys to move up or down the list.  The listings for that station 
are displayed on the right side of your screen. 

There are two ways to view listings in the Stations tab.  You 
control how the listings are displayed via the Stations tab 
Format option:

1 Log view is the standard view.  Each station is shown in its 
own, rolling log.

2 Grid view can be activated from the Grid Mode option of 
the View menu (see Views on page 47).  Each station is 
shown as a 24-hour grid.

• Use the arrow keys to scroll up or down.  You can also scroll 
using the horizontal and vertical scroll bars.
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• Scroll to a specific program to display its details in the area 
above the list.

• To display just the stations you want, use the Station Lists 
option in the Edit menu (see To customize channels on 
page 45).

Titles tab

The Titles tab displays all titles in the current listings, on the left 
side of your screen.  Click a title to display all show times for 
that title, on the right side of your screen.

• Use the arrow keys to scroll up or down.  You can also type a 
partial or full Title name in the textbox above the Title list, 
and quickly jump to a particular title.

• Scroll to a specific program to display its details in the area 
above the log.

• To display just the stations you want, use the Station Lists ... 
option in the Edit menu (see To customize channels on 
page 45).

Days and dates

Each view contains listings for the current date.  To change the 
date, select the date you wish to view from the Dates menu at 
the top of the screen.
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Stills Gallery

The still images you 
capture from TV, Video 
CD, or File Player are 
saved in the Stills Gallery.  
You can save images in a 
variety of graphics 
formats and sizes.  The 
Stills Gallery controls let you delete images, hide them, save 
them as wallpaper, and print them.  

When you click the logo in the upper left corner of the Stills 
Gallery, the “About...” notice appears.  If you have more than 
one feature installed, a Task menu displays available and active 
features.  

For information about using the Stills Gallery controls, see the 
online help and Tool Tips.

Stills Gallery settings

Use the Stills Gallery Setup page to define how the Stills 
Gallery saves and prints captured images.

Note
If you close the Stills Gallery without saving, your 
captured still images are deleted.
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To set up the Stills Gallery

Click the Setup button in the Stills Gallery, TV, File 
Player, or Video CD control panel, then click the Stills 

Gallery tab. 

Capture
Options

Capture to Gallery
Captures still images to the Stills Gallery.

Capture to numbered file
Stores captured images in numbered files (pic001.bmp, 
pic002.bmp ...) on your hard disk.

Capture to clipboard
Places captured images on the Windows Clipboard.

Capture to printer
Send the captured image to the printer.

Use only 256 colors
Saves captured images as 256-color files, to save disk 
space.

Save
Options

Warn if closed without saving
Alerts you if you close Television or the Stills Gallery 
without saving captured images.

Show paths of saved images
Displays the drive, folders, and subfolders that contain 
saved images.

Tool
Tips

Show Tool Tips
Display tool tips for the Stills Gallery controls.

Show Short Cut
Display shortcut keys for the Stills Gallery controls.

Always
on top

Keep the Stills Gallery on top of other applications.

Print
Options

Center image
Print image in center of page.

Image size:
Maximize Print in full-page format.
One to one Print same size as original.
Double Print twice original size.
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CD Audio

Use CD Audio to play 
standard audio CDs.  
Advanced features such as 
Random play, Intro play 
(which plays the first ten 
seconds of each track) and 
Loop play are available.  The Schedule feature lets you schedule 
CD playback on dates and times you specify (see Schedule on 
page 83).

When you click the logo in the upper left corner of the display 
panel, the “About...” notice appears.  If you have more than one 
feature installed, a Task menu displays available and active 
features.

For information about using CD Audio controls, see the online 
help and Tool Tips.

To start CD Audio

from LaunchPad

Click CD Audio in the Launchpad.  For information on 
LaunchPad, see page 8.

from Windows® taskbar

1 In the Windows taskbar, click Start.

2 Point at Programs .

3 Point at ATI Multimedia Center .

4 Click CD Audio.

You can also start CD Audio from other Multimedia 
Center features—DVD, Video CD, TV, and File Player.  

Click the ATI logo in the upper left corner of the feature’s 
control panel, then click CD Audio.
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CD Audio settings

Use the CD Audio Settings page to set up playlists and shuffle 
play, and to use an LCD panel for track number and playback 
time.

To set up CD Audio

Click the Setup button in the CD Audio control panel, 
then click the CD Audio Settings tab. 

Play
List

Displays all tracks in the playlist (the list of your 
selections).

Shuffle
Play

Shuffle all tracks
Play all tracks in random order.

Shuffle user playlist
Play playlist in random order.

Disc
Information

If the information is available, displays the name of the 
disc and the artist.  You can also type in the information.

Available
Tracks

Displays the tracks that you can add to the playlist.  Use 
the buttons to add or remove selected tracks or all tracks.

LCD
Display

Check to display track number and current playback time 
on an LCD display.

Tool
Tips

Show Tool Tips
Display tool tips when you point at a control with your 
mouse.

Show Shortcut
Display keyboard shortcuts when you point at a control 
with your mouse.
Download from Www.Somanuals.com. All Manuals Search And Download.



Using Your ATI Multimedia Center     59
CD Database

If you are connected to the Internet, you can use the CD 
Database to display album title, artist, song names, and other 
information on your computer as your CD plays.  

When you put an audio CD in your CD-ROM drive, the CD 
Audio program can query a global CDDB server for 
information about the disk.  If the database contains information 
for your disk, CD Audio downloads and displays the data. 

• Access to the CDDB service is free of charge to end-users.  

To open the CD Audio CD Database page

Click the Setup button in the CD Audio control panel, 
then click the CD Database tab. 

Server
Address of 
CDDB server
(default:
cddb.cddb.com)

Port
Port to use with this CDDB server (default: 8880).

Get Sites List from Server
Get sites list from server using current settings.

Protocol

CDDBP
Use direct TCP/IP connection.

HTTP
Use the HTTP connection if you are behind a firewall.  A 
CGI script must be defined (default: /-cddb/cddb.cgi)

Proxy Server
Access the
database using
a proxy server

Server
Address of proxy server (a proxy server is another 
computer on your LAN that connects to the Internet 
without compromising the security of your network).

Port
Port to use with proxy server.

Requires Proxy Authentication
This proxy server requires authentication.
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CD Audio Schedule settings

You can schedule CD Audio to play on the dates and times you 
specify.  If you have the features installed, you can also 
schedule events for TV Magazine, Digital VCR, File Player, and 
TV.

To open the CD Audio Schedule settings page

Click the Setup button in the CD Audio control panel, 
then click the Schedule tab.  The Schedule Wizard will 

guide you through creating new scheduled events.  See Schedule 
on page 83 for details. 

Dial-Up
Networking
Use dial-up
networking
when accessing
the server.

Use this connection when making remote queries
When not connected, connect using this entry.

Only perform remote queries when connected
Access the database only when already connected.

Disable 
CD Database

No queries are performed when this box is checked.
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Video CD

Video CD plays Video CD 
1.0 CDs and Karaoke CDs.

When you click the logo in 
the upper left corner of the 
display panel, the 
“About...” notice appears.  
If you have more than one 
feature installed, a Task 
menu displays available 
and active features.

For information about 
using Video CD controls, 
see the online help and 
Tool Tips.

To start Video CD

from LaunchPad

Click Video CD in the Launchpad.   For information on 
LaunchPad, see page 8.

From Windows® taskbar

1 In the Windows taskbar, click Start.

2 Point at Programs .

3 Point at ATI Multimedia Center .

4 Click Video CD.

You can also start Video CD from other Multimedia 
Center features—TV, CD Audio, File Player, and DVD.  

Click the ATI logo in the upper left corner of the feature’s 
control panel, then click Video CD. 
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Video CD Control menu

You can access Video CD functions by right-clicking on the 
video viewing area or the control panel.  This is very useful in 
full-screen mode.  The following menu items are available: 

Setup Open the Video CD setup page.

Eject CD Eject the video CD from the drive.

Play 

Pause 

Stop

Play the loaded Video CD. 

Pause playback. 

Stop playback.

Display Size

50% Display video at 1/2 size. 

75% Display video at 3/4 size.

100% Display video full size. 

200% Display video at double size. 

Full Screen Display video in full screen, no borders.

Show 
Controls

Display the Control panel.

Audio 
Channels

Click to select audio tracks for dual-mode MPEG CDs: 

Stereo Stereo audio playback.

Both Channels Both audio channels active.

Left Channel Left channel audio only.

Right Channel Right channel audio only.

Movie Scale

Show Time Display scale in time.

Show Frames Display scale in frames.

Time Remaining Display time remaining in current CD.

Total Time Display total time of current CD.

Zoom

Unzoom Return to normal display.

Zoom 2x Zoom to double size.

Zoom 4x Zoom to 4 times size.

Zoom 8x Zoom to 8 times size.

About... Display the About... dialog.

Exit Close the Video CD program.
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Capturing still frames from Video CDs

To capture still frames from Video CDs

Click the Camera button in the Video CD control panel.  
The current frame is placed in the Stills Gallery (see 
Stills Gallery on page 55). 

Zooming and Panning

You can zoom in on the video in 
the Display panel to enlarge a 
selected portion of the screen, and 
return your display to normal.

To zoom in

Click within the display panel, 
then hold down the mouse button 
and draw a rectangle around the 
area you want to zoom.  

 Or, right-click the 1:1 button  to open a menu where you 
can set the zoom level— Zoom x2, Zoom x4, or Zoom x8.

To pan in the zoomed area

Move your mouse within the zoomed area.

To zoom in the zoomed area

Hold down the Shift key, and draw another rectangle in the 
zoomed area.

To unzoom or use predefined zoom levels

Right-click in the display panel to open the Control Menu (see 
Video CD Control menu on page 62), then click Zoom, and 
select Unzoom, Zoom x2, Zoom x4, or Zoom x8.

 Or, click the 1:1 button to unzoom, or right-click the button 
to open a menu where you can set the zoom level — Zoom x2, 
Zoom x4, or Zoom x8.
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Video CD Display settings

Use the Video CD Display settings pages to set up video size 
and general operation.

To open the Video CD Display settings page

Click the Setup button in the Video CD control panel, 
then click the Display tab. 

Video 
Size

Choose playback size: 50%, 75%, 100%, 200%, or 
Fullscreen.

Tool Tips

Show Tool Tips
Show tool tips when you point at controls with your 
mouse.

Show Shortcuts
Show keyboard shortcuts when you point at controls with 
your mouse.

Always
on top

Keep Video CD on top of other applications.

Keep Aspect
Ratio

Maintain the width-to-height ratio when you resize or 
zoom the display.

Autohide
Controls in
Full screen

Automatically hide Video CD controls when playing full-
screen.
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Video CD Preferences settings

Use the Video CD Preferences settings page to set up general 
characteristics for your player.

To open the Video CD Preferences settings page

Click the Setup button in the Video CD control panel, 
then click the Preferences tab. 

Movie
Scale

Show Frames
Display scale in frames.

Show Time
Display scale in time.

Show Total Time 
Display the total time of the playing video CD or file.

Show Time Remaining 
Display the remaining time in the playing video CD or file.

General 
Settings

Automatically play a loaded CD.

Power 
Management

Select one of the following levels: 

Always
Power management always enabled. 

Disabled while playing
Power management is disabled while a CD is playing. 

Allow display to turn off while paused
Only the display turns off when playback is paused.

Disabled
Power management is never enabled.
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Video CD Stills Gallery settings

You can capture still images from Video CDs, and save them in 
the Stills Gallery.

To open the Video CD Stills Gallery settings page

Click the Setup button in the Video CD control panel, 
then click the Stills Gallery tab.  For information on the 
Stills Gallery, see Stills Gallery on page 55.
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DVD

DVD (Digital Versatile 
Disc) is a high-density 
format that provides as 
much as 17 Gigabytes of 
storage—25 times more 
than a CD-ROM.  This 
vastly increased capacity 
lets you view a full-length 
movie or play games that 
used to require multiple 
CDs. 

Many DVD titles provide 
new viewing capabilities: interactive menu selection, multiple 
languages, foreign-language subtitles, multiple viewing angles, 
and more.  New video and audio technologies such as MPEG-2 
video compression give you a higher level of multimedia video 
and audio experience. 

When you click the logo in the upper left corner of the display 
panel, the “About...” notice appears.  If you have more than one 
feature installed, a Task menu displays available and active 
features.  

For information about using the DVD controls, see the online 
help and Tool Tips.

To start DVD 

from LaunchPad

Click DVD in the Launchpad.  For information on LaunchPad, 
see page 8.

from Windows® taskbar

1 In the Windows taskbar, click Start.

2 Point at Programs .

3 Point at ATI Multimedia Center .

4 Click DVD.
Download from Www.Somanuals.com. All Manuals Search And Download.



68  Using Your ATI Multimedia Center     
You can also start DVD from other Multimedia Center 
features installed on your system—TV, Video CD, File 

Player, and CD Audio.  Click the ATI logo in the upper left 
corner of the feature’s control panel, then click DVD. 

What can I play on my DVD drive?

You can play all video discs that conform to the DVD Video 
Disc 1.0 specification, including encrypted (copy-protected) 
and interactive titles.  

Sizing the Video Display panel

You can resize the video display panel by using your mouse to 
drag an edge, and you can use the CTRL key to display these 
preset screen sizes:

Full-screen controls

When you play 
DVD discs in 
full-screen mode, the player controls appear at the bottom of 
your screen.  You can use the following keys to return to 
windowed video, and hide or show the on-screen controls.

50% of original size. CTRL+1

75% of original size. CTRL+2

100% of original size. CTRL+3

Full-screen
CTRL+4
CTRL+F

Ctrl + F Exit full-screen mode.

F2
Hide / Show the 
on-screen controls.
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Playing DVD Video Disks

All DVD players and drives will read audio CDs and 
CD-ROMs, and play music from Enhanced CDs (CD Plus, CD 
Extra).

To play DVD discs

Place a DVD disk in your DVD drive, then click the Play DVD 
button in the File Open dialog.

Selecting audio streams

When you view a standard DVD Video disc that has 
multiple audio streams, clicking the audio channel 
button displays a pop-up menu of available audio 
streams.  The currently-playing channel is checkmarked.

• All DVD Video Discs support up to eight audio channels.

Setting up sub-titles

Click the sub-title selection button in the DVD control 
panel to display a menu of sub-title language choices.  
Click the language you want for sub-titles.  The selected 
language is checkmarked.

• All DVD Video Discs support up to thirty-two sub-title 
languages.
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Using the menus

Click the Menus button in the DVD control panel.  A 
pop-up “menu of menus” opens, where you can select a 
menu to jump to.  Standard DVD Video Discs provide up 
to six menus:

• Title (usually, a whole movie or album)

• Root

• Audio 

• Sub-picture (sub-pictures overlay the video, and are used for 
sub-titles, karaoke, menus, simple animation, etc.).

• Angle 

• Chapter

Searching DVD disks

DVD Video Disc content consists of “titles” (movies or 
albums), and “parts of titles” (chapters or songs).  Use Search to 
go to a specific location on the disc.

Click the Search button in the DVD control panel to open 
the search dialog.  You can search DVD discs for:

• Title (usually a whole movie)

• Title and Chapter (a Chapter is part of a Title).

• Time within the current Title and Chapter in HH:MM:SS:FF 
format:  HH=hour, MM=minute, SS=second, FF=frame).

Selecting viewing angle

Click the Angle button in the DVD control panel to 
display a menu of camera angles.  The selected angle is 
checkmarked.

• Not all DVD Video Discs support multiple viewing angles; 
the DVD content must be encoded with multiple viewing 
angles for this feature to be active.
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Parental Control

Parental Control lets you restrict access to selected 
material by requiring password access.  Click the 
Parental Lockout button in the DVD control panel to 
display a menu of parental level choices.  The selected 
level is checkmarked.

• When a parental level is selected, a password dialog appears.  
A password is required to change parental levels. 

Zooming and Panning

You can zoom in on the video in 
the Display panel to enlarge a 
selected portion of the screen, and 
return your display to normal.

To zoom in

Click within the display panel, 
then hold down the mouse button 
and draw a rectangle around the 
area you want to zoom.  

 Or, right-click the 1:1 button  to open a menu where you 
can set the zoom level— Zoom x2, Zoom x4, or Zoom x8.

To pan in the zoomed area

Move your mouse within the zoomed area.

To zoom in the zoomed area

Hold down the Shift key, and draw another rectangle in the 
zoomed area.

To unzoom or use predefined zoom levels

Right-click in the display panel to open the Control Menu (see 
DVD Control menu on page 72), then click Zoom, and select 
Unzoom, Zoom x2, Zoom x4, or Zoom x8.

 Or, click the 1:1 button to unzoom, or right-click the button 
to open a menu where you can set the zoom level — Zoom x2, 
Zoom x4, or Zoom x8.
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DVD Control menu

As well as using the control panel buttons, you can access DVD 
functions by right-clicking on the video viewing area or the 
control panel.  This is very useful when you play files in full-
screen mode.  The following menu items are available:

Setup Opens the Preferences page.

Hide controls
Hides the full-screen controls (see Full-screen 
controls on page 68).

Eject Ejects the DVD disc from the drive.

Resume Continues play, after pausing

Play/Pause Toggles between play and pause.

Stop playing Stops play.

Play at 
specific part

Search for a specific location on the disc (see 
Searching DVD disks on page 70).

Restart program Starts play at the beginning of the file.

Go Up Goes up in a playlist.

Menu
Displays a “menu of menus” (see Using the menus 
on page 70).

Subtitle
Displays a menu of subtitle language choices (see 
Setting up sub-titles on page 69).

Audio
Displays a menu of audio streams (see Selecting 
audio streams on page 69).

Angle
Displays a menu of camera angles (see Selecting 
viewing angle on page 70).

Parental
Control

Displays a menu of parental level settings.

Search Search for any title or chapter.

Zoom Zoom 2x, 4x, 8x, Unzoom.

About... Displays the About... dialog.

Exit Closes DVD.
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DVD display settings

The Display settings page lets you control how video is 
displayed in DVD.

To open the Display settings page

Click the Setup button in the DVD control panel, then 
click the Display tab.

Display
Size

Display video at 50%, 75%, 100%, or full screen.

Layout
Preference

If the DVD video disc contains the appropriately formatted 
content, DVD video can be displayed with a width-to-
height ratio of 4:3 (standard TV shape) or 16:9 
(widescreen).

Wide screen
Displays the full image with a width-to-height ratio of 16:9 
(for wide-screen TVs).

Letterbox
Displays the image with top and bottom borders (in 4:3 
format, for a shorter but full-width image).

Pan Scan
Displays a 16:9 image formatted to fit a standard 4:3 
screen; the image is full-height and 75% of the full width.

Options

Keep Aspect Ratio
Maintains the aspect ratio (width-to-height ratio) when 
you resize the display. 

Always on Top
Always displays the player on top of other windows.

Auto Hide in Full Screen
Automatically hides controls in full-screen mode if no user 
interaction occurs.  Controls automatically re-appear if 
you move the mouse.

Tool
Tips

Show Tool Tips
Displays helpful aids for using DVD.

Show Shortcut
Displays shortcut keys.
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DVD Preferences settings

The Preferences settings page lets you control how video is 
displayed in DVD.

To open the Display settings page

Click the Setup button in the DVD control panel, then 
click the Preferences tab. 

Preferred
Language

Select a 1st choice and a 2nd choice for your preferred 
language.
• DVD automatically selects the audio stream and sub-

titles to match the 1st choice.
• If the 1st choice is not available, the 2nd choice is 

used.
• If neither 1st or 2nd choice is available, the player 

uses the first available audio and sub-picture stream.
• You can use the Sub-titles button to change 

languages during playback (see Setting up sub-titles 
on page 69).

Power
Management

Select one of the following levels:

• Always (power management always enabled).
• While not playing
• Display to turn off while paused (only the display 

turns off when playback is paused).
• Never

Enable
Subtitles
Always

Always display subtitles.

Show
Subtitles
When Muted

Display subtitles whenever the audio is muted.
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DVD Video settings

The Display Settings page lets you adjust video characteristics.  
Your hardware will determine which settings are available. 

To open the DVD Video settings page

Click the Setup button in the DVD control panel, then 
click the Video tab.  

DVD Closed Captioning

Display closed captioned 
text over video, and/or in a 
separate window beside the 
video.  When you use the 
separate window, you can 
use the scroll bar to review 
the last few minutes of text.  
You can set the background 
color, the font, and the font color for the window.

To display closed-captioned text

Click the Closed Caption button in the DVD control 
panel. 

To close the Closed Captioning window, click the Exit 
button.

Brightness Adjusts the intensity of light in your display.

Gamma
Adjusts the color brightness of your display.  The higher 
the gamma, the higher the brightness and contrast, with 
maximum being a flat (unmodified) setting.

Saturation
Adjusts the richness of color (determined by the amount 
of grey in a color) in your display.

Note Closed-Captioning is only available in North America.
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Closed Caption settings

The Closed Caption settings page lets you specify how closed 
captioned text is displayed—over video or in a window—and 
the background color, the font, and the font color for the 
window.  

To set up closed captioning

Click the Setup button in the DVD control panel, then 
click the Closed Caption tab. 

DVD Schedule settings

If you have the features installed, you can schedule events for 
TV Magazine, Digital VCR, File Player, and TV.

To open the DVD Schedule settings page

Click the Setup button in the DVD control panel, then 
click the Schedule tab.  The Schedule Wizard will 

guide you through creating new scheduled events.  See Schedule 
on page 83 for details. 

Placement

External Window
Displays closed captioned text in its own window.  Click 
Font... to select the display font.

Video Window
Displays closed captioned text superimposed on the 
video.  Click Font... to select the display font.

Solid Background
Displays closed captioned text on a solid background.
Shaded Background
Displays closed captioned text on a shaded background.

Closed
Caption
On Mute

Display closed captioned text when the audio is muted.
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Region codes

There are six region codes, or “country codes”, which are used 
to prevent playback of certain discs in certain geographical  
regions.  DVD players will not play discs that are not allowed in 
the region.  

If you insert a DVD disc whose region code is different from the 
currently-set value, a dialog appears where you can change the 
region code for your location.

You can only change Region Codes five times. 

Region 1 The U.S., U.S. territories and Canada.

Region 2
Europe, Japan, the Middle East, 
Egypt, South Africa, Greenland.

Region 3
Taiwan, Korea, the Philippines, 
Indonesia, Hong Kong.

Region 4
Mexico, South America, Central 
America, Australia, New Zealand, 
Pacific Islands, Caribbean

Region 5
Russia, Eastern Europe, India, most of 
Africa, North Korea, Mongolia.

Region 6 China
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File Player

Use the File Player to play 
various multimedia file 
formats.  The types of file 
you can play depends on 
your system’s software.  
For example, MPEG-2 
file playback is available 
if software such as ATI’s 
DVD Player is installed.

You can play the 
following, multimedia 
files: 

• AVI

• MPEG (,mpg, .mpeg)

• MP (.mp3, .mp2)

• MIDI (.mid)

• WAV (.wav)

For information about using File Player controls, see the online 
help and Tool Tips

To start File Player 

from LaunchPad

Click File Player in the Launchpad.  For information on 
LaunchPad, see page 8.

from Windows® taskbar

1 In the Windows taskbar, click Start.

2 Point at Programs .

3 Point at ATI Multimedia Center .

4 Click File Player. 
Download from Www.Somanuals.com. All Manuals Search And Download.



Using Your ATI Multimedia Center     79
File Player Control menu

You can access File Player functions by right-clicking on the 
video viewing area or the control panel.  This is very useful 
when you play files in full-screen mode.  The following menu 
items are available: 

Setup Open the File Player Setup page.

Hide/Show 
Controls

Hide the File Player Control panel.

Play Play the current file.

Stop Stop playing.

Time display 
mode

Set time mode: 
Elapsed Time 
Remaining Time 
Total Time

Zoom Mode
Set Zoom: 
Unzoom, Zoom 2x, 
Zoom 4x, Zoom 8x.

Video Size
Set playback size: 
50%, 75%, 100%, 200%, Full Screen.

About... Displays the “About” dialog.

Exit Closes the File Player.
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Zooming and Panning

You can zoom in on the video in 
the Display panel to enlarge a 
selected portion of the screen, and 
return your display to normal.

To zoom in

Click within the display panel, 
then hold down the mouse button 
and draw a rectangle around the 
area you want to zoom.  

 Or, right-click the 1:1 button  
to open a menu where you can set the zoom level— Zoom x2, 
Zoom x4, or Zoom x8.

To pan in the zoomed area

Move your mouse within the zoomed area.

To zoom in the zoomed area

Hold down the Shift key, and draw another rectangle in the 
zoomed area.

To unzoom or use predefined zoom levels

Right-click in the display panel to open the Control Menu (see 
File Player Control menu on page 79), then click Zoom, and 
select Unzoom, Zoom x2, Zoom x4, or Zoom x8.

 Or, click the 1:1 button to unzoom, or right-click the button 
to open a menu where you can set the zoom level — Zoom x2, 
Zoom x4, or Zoom x8.
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File Player Display settings

The Display settings page lets you control how video is 
displayed in the File Player.

To open the Display settings page

Click the Setup button in the File Player control panel, 
then click the Display tab. 

Video
Size

Display video at 50%, 75%, 100%, 200%, or full screen.

Options

LCD Display
Display track number and current playback time on an 
LCD display.

Always on Top
Always display File Player on top of other applications.

Auto Hide Controls when in Full Screen
Automatically hides controls in full-screen mode if no user 
interaction occurs.  Controls automatically re-appear if 
you move the mouse.

Keep Aspect Ratio
Maintains the aspect ratio (width-to-height ratio) when 
you resize the display.

Time 
Mode

Set the time mode:
Elapsed Time, Remaining Time, or Total Time.

Tool
Tips

Show Tool Tips
Displays helpful aids for using the File Player.

Show Shortcut
Displays shortcut keys.
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File Player Preferences settings

The Preferences settings page lets you specify power 
management settings. 

File Player Stills Gallery settings

You can capture still images from the File Player.

To open the File Player Stills Gallery settings page

Click the Setup button in the File Player control panel, 
then click the Stills Gallery tab.  For information on 
Stills Gallery, see Stills Gallery on page 55. 

File Player Schedule settings

You can schedule the File Player to play media files on the dates 
and times you specify.  If you have the features installed, you 
can also schedule events for CD Audio, TV Magazine, Digital 
VCR, and TV.

To set up scheduled events

Click the Setup button in the File Player control panel, 
then click the Schedule tab.  The Schedule Wizard will 

guide you through creating new scheduled events.  See Schedule 
on page 83 for details. 

Power
Management

Select one of the following levels:

Always
Power management always enabled.

Disabled while playing
Power management is disabled while a CD is playing. 

Allow display to turn off while paused
Only the display turns off when playback is paused.

Disabled
Power management is never enabled.
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Schedule

Use the Schedule feature to activate events on the dates and 
times you want.  You can schedule events for CD Audio, TV 
Magazine, Digital VCR, File Player, and TV.

To set up scheduled events

Click the Setup button in the DVD, TV, CD Audio, or 
File Player control panel.  Click the Schedule tab, and 

then click the Create New button.

The Schedule Wizard will guide you through creating new 
scheduled events.  Step 4 of the Wizard asks if you want to set 
up feature-specific settings (for example, if you are recording 
video, you can specify quality and duration for particular 
events).  When you click the Finish button, your event is added 
to the scheduled event list; checked items are active. 
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Schedule settings 

Name The name of the event.  Checked events are active.

Feature
The feature to schedule: CD Audio, File Player, Television, 
TV Magazine, Video Capture, or Video CD.

When When the event occurs.

Next Run
Time

The next time the event will run.

Modify Click to change values for a scheduled event.

Delete Remove a scheduled event.

Delete All Remove all scheduled events.

• Events whose date (On Month & Day) has passed are not automatically 
removed.  To re-activate an event, set its Month & Day to today or later.

• If a settings page is open, or if the About Help... box is being displayed, 
the Scheduler cannot process events.  If an event occurs, a warning 
dialog tells you that a particular event was not processed.

• When the Multimedia Center first runs, if there are any scheduled events 
recorded, and the Scheduler program is not running, a warning dialog 
tells you that the scheduled events will not be processed.

You can run the Scheduler immediately, and/or install it in your Windows 
Startup file, so that it runs every time Windows is started.  the warning 
dialog is displayed whenever you click OK after adding an item to the 
scheduled viewing list.
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TV Out

You can connect a television set as your computer’s display, and 
use your Multimedia Center to view computer output directly 
on your television in NTSC or PAL formats, connect using 
Composite or S-Video output capabilities, and display images 
on the TV and PC monitor simultaneously.

TV Out provides a big-screen experience for entertainment PCs 
that is ideal for playing games, giving presentations, watching 
movies, and browsing the Internet. 

To enable the television display

1 In the Windows taskbar, click Start.

2 Point to Settings , then click Control Panel.

3 Double-click Display.

4 Click the Settings tab.

5 Click Advanced...

6 Click Displays.

7 Check the Television checkbox.

8 Click OK.

To cancel TV Out, click the Television checkbox to clear it.

For more information about television display, click  
Desktop Help.

Note
You must attach a TV before enabling TV out.  For 
information on attaching a TV, see the User’s Guide 
for your ATI card.
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Multi-monitor support

ATI RADEON VE cards with integrated  
HydraVision™ software provide flexible, 
multi-monitor support for your system.  Many 
configurations of CRT, DVI flat panel, and TV 
monitor displays are available.  

ATI RADEON VE cards, provide Multi-monitor support for 
DVD, File Player, and Video CD.  For details, please see the 
RADEON VE Installation and Setup User’s Guide.

Teletext

ATI’s new Teletext 
application lets you get 
the most out of working 
with Teletext.  ATI 
Teletext eliminates all the 
familiar disadvantages of 
television’s teletext, and 
allows you to surf in the 
teletext data stream.  The 
ATI Teletext User’s Guide 
provides  complete installation and operating instructions. 

Note Teletext is only available in Europe.
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Troubleshooting

If you have problems with video or audio, try these suggestions. 

Audio problems ...

Check your speakers:

• If you have external speakers, ensure that they are powered-
on (POWER indicator light is on) and connected to the 
LINE-OUT or SPEAKER OUT connectors on your sound card.  

Play a .WAV sound:

1 Click Start, point at Settings , select Control Panel, 
then double-click Sounds.

2 In the Events area, Click Asterisk, then click a .WAV file 
in the Sound area.

3 Click the Play button  to preview the sound.

If you still do not hear any sound, open the Volume Control:  

• Click Start, point at Programs , point at Accessories , 
point at Entertainment , then select Volume Control.
Or, right-click the speaker icon  (usually in the lower-right 
corner of your screen), then click Open Volume Controls.

• Ensure that the Volume Control and the Wave channel are 
not muted or set very low.  Also ensure that the MIDI (or 
Synthesizer) channel is not muted. 

No sound

Still no sound?

If the speaker icon is not in your Taskbar, do the following:
• In the Windows Taskbar, click Start, point to Settings, 

then click Control Panel.
• Double-click Multimedia. 
• In the Audio tab, check Show volume control on the  

Taskbar.
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When you hear sound from your speakers, you know they are 
working.  

• If you still experience audio problems, check the audio 
connections to your ALL-IN-WONDER 128 family card.

Ensure that the audio connection between your 
ALL-IN-WONDER 128 family card or ALL-IN-WONDER 
RADEON card and your sound card is correct. 

• For complete installation instructions, refer to the 
ALL-IN-WONDER 128 / ALL-IN-WONDER 128 PRO / 
ALL-IN-WONDER RADEON Installation and Setup User’s 
Guide.  

No sound from TV

ALL-IN-
WONDER
128 Family 

card or 
ALL-IN-

WONDER 
RADEON

A/V IN

CATV

A/V OUT

output 
adapter

LINE IN

SOUND
CARD
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Check the Record mixer settings:

1 Click Start, point at Programs , point at Accessories , 
point at Entertainment , then select Volume Control.
Or, right-click the speaker icon  (usually in the lower-
right corner of your screen), then click Open Volume 
Controls.

2 In the Volume Control menu, click Options, click 
Properties, click Recording, then click OK.  The 
Recording Control opens.

3 Ensure that Line (or the Audio input you selected in the 
Sound Initialization Wizard — see page 13) is checked, 
then click  to close the dialog.  

Connect the VCR audio output to your PC:

• Left and right audio output from your VCR must be 
connected to your ALL-IN-WONDER 128 family card or 
ALL-IN-WONDER RADEON card (note that S-Video does 
not provide an audio connection).  For complete installation 
instructions, refer to the ALL-IN-WONDER 128 / 
ALL-IN-WONDER 128 PRO / ALL-IN-WONDER RADEON 
Installation and Setup User’s Guide. 

Can’t capture sound

Can’t capture sound when 
recording from a videotape.

S-VIDEO
OUT

 COMP.
VIDEO
OUT

L. AUDIO
OUT

R. AUDIO
OUT

ALL-IN-
WONDER 

128 
Family 
card or 
ALL-IN-

WONDER 
RADEON

A/V IN

CATV

A/V OUT

OR

S L R

ATI Input Adapter
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Connect your PC audio to the VCR:

• Left and right audio output from your VCR must be 
connected to your ALL-IN-WONDER 128 family card or 
ALL-IN-WONDER RADEON card (note that S-Video does 
not provide an audio connection).  For complete installation 
instructions, refer to the ALL-IN-WONDER 128 / 
ALL-IN-WONDER 128 PRO / ALL-IN-WONDER RADEON 
Installation and Setup User’s Guide. 

No sound on the videotape 
when outputting to a VCR

ALL-IN-
WONDER

128 
Family 
card or 
ALL-IN-

WONDER 
RADEON

A/V IN

CATV

A/V OUT

S-VIDEO
     IN

 COMP.
VIDEO
    IN

L. AUDIO
     IN

R. AUDIO
      IN

output 
adapter

LINE IN

SOUND
CARD

OR

LINE OUT
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Video problems ... 

Check that you are using the correct broadcast standard 
format: 

• See Broadcast Standard in TV video settings on page 17.  For 
proper operation, you must specify your country in the TV 
Channels Initialization Wizard (see page 13).

• Check the quality of your incoming TV signal on another 
receiver; bad reception may be the cause. 

• Ensure that your cable or antenna is connected.

• Ensure that the video connector is set to the correct source 
(see Connector in TV video settings on page 17).

• Check that the audio and video connectors are securely 
plugged into the correct jacks.

• Check that your video card is securely seated in its slot.  
Please refer to the user guide for the card location. 

Video is unstable or only black and white

There is no video or audio
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